
   

The Villages Computer Club will meet at 1 p.m. Friday Sept 20th at Hacienda 

Recreation Center. 

The program will feature a presentation on Using email effectively by Bobbie Seabolt, 

Following the presentation will be refreshments, door prizes and a problem 
solving session.  

Guests are always welcome, please bring your village ID card. For information or 

to sign up to be on the VCC email list, visit the website or email Paul Rabenold at 

TVCC.Pres@gmail.com 

******************************************************************

*** 

A great way to learn about your computer, programs and securing your computer. 

1. Open your browser (Internet Explorer, Google Chrome, Firefox, other). 

2. Type into the address bar or click the link below  

www.thevillagescomputerclub.com. 

3. Click Presentations. Scroll down to see the list of presentations made at the VCC 

Friday Meetings. 

4. Click the link in the last column, Presentation File and select Open or you may 

click SAVE to save the file to your computer. 

*************************************************************** 

Win 8 Startup Menu 

To enter the STARTUP Menu for Win 8 to add or remove items from startup, 

1. Press down the Windows key and press the r key on the keyboard to bring up RUN. 

2. Type into the RUN box msconfig and press OK. 

3. Select the STARTUP tab. 

4. Uncheck any item that you do NOT wish to have startup every time you start your 

computer. Check those items that must be started such as your anti-virus program. 



Note: If you've not added RUN to your Win 7 program list, you can reach Startup using the 

same Windows Key + the r key. 

********************************************************** 

You may want to print this 'bit' and keep it near-at-hand. 

Windows Keyboard and Key Functions 
 

Windows Key 

 

Windows Key = Start Menu 

 

Holding down the Windows Key and pressing: 

 

E = Windows Explorer 

F = Find or Search Dialog Box 

M = Minimizes All Open Windows 

Shift+M = Maximizes All Open Windows 

R = Run Box 

Pause/Break = System Properties 

 

CTRL (Control) Keys 

 

Holding down one of the CTRL (Control) Keys and pressing: 

 

A = Select All  B = Bold         C = Copy 

I = Italics   P = Print  S = Save 

U = Underline  V = Paste  X = Cut 

Z = Undo   Esc = Start Menu  

 

Holding down the CTRL Key and pressing the HOME Key will take you to the Beginning 

of a document. 

 

Holding down the CTRL Key and pressing the END Key will take you to the End of a 

document. 

 

ALT Keys 

 

Holding down one of the ALT Keys and pressing: 

 

H = bring up the Help menu in a program 

Tab = switch between all open programs 

F4 = close the current open program 

Prt Scr = copy the ‘active’ window to the computer’s clipboard 

 



CTRL and ALT Keys Together 

 

Holding down the CTRL & ALT Keys together and pressing: 

 

Delete Key = Close Program Box appears  (Windows Task Manager) 

Delete Key 2X = restart your computer 

 

 

 

Word Processing Keys 

 

Insert Key = toggles between insert and type over in a document. 

 

Delete Key = sends selected item or what is to the right of the cursor to the recycle bin. 

 

Home Key = goes to the beginning of the active line. 

 

End Key = goes to the end of the active line. 

 

Page Up = goes up the document one monitor viewing area of the screen. 

 

Page Down = goes down the document one monitor viewing area of the screen.  

 

Cursor Keys 

 

Scroll through documents without any changes being made. 

 

Numbers Key Pad 

 

Num Lock ON = number pad can be used as a calculator 

 

Num Lock OFF = the number pad keys are the as as Word Processing Key and Cursor 

Keys. 

 

Shift Keys 

 

Holding down one of the Shift Keys and pressing: 

 

Any letter will type that letter capitalized in a document. 

 

A number key will type the Special Character listed above the number. 

 

The Delete Key will delete a selected item without sending it to the recycle bin. 

 

Caps Lock Key 

 



Caps Lock Key ON = type all upper case letters. Will NOT type special characters above 

the number keys. 

 

Caps Lock Key Off = turn OFF the upper case typing. 

 

 

Tab Key 

 

When pressed will move the cursor to the next set tab. The default on most documents is 

every half inch. 

 

In a form when pressed will jump to the next box for information input. 

 

Shift Tab will go back one box. 

 

Backspace key - Will erase the letter to the Left of the cursor. 

 

Delete Key - Will erase the letter to the Right of the cursor. 

 

ESC (Escape) Key – Cancels the current task. 

 

Print Screen Key 

 

Pressing the Print Scr Key will copy the viewing area of the monitor to the clipboard for 

pasting into a program where it can then be viewed or printed. 

 

Holding down the ALT Key when pressing the Print Scr Key will copy ONLY the active 

window to the clipboard for pasting into a program where it can be viewed or printed. 

 

Scroll Lock Key 

 

Scroll Lock Key is to convert a laptop keyboard to alpha-numberic use. 

 

Toggle between two computers using the same mouse, monitor & keyboard. 

 

Pause-Break Key 

 

Holding down the Window Key and pressing the Pause/Break Key will bring up System 

Properties screen. 

 

Function Keys (F1 – F12) 

 

Standard Windows Keyboard and the Laptop Keyboard has Function Keys in the top row 

of keys. 

 



The Laptop keyboard is smaller and the number key pad is located within the letter keys 

and is activated by pressing the Scroll Lock Key.  Also, some Laptop Function keys require 

pressing the FN key to activate. 

Function Keys 

 

F keys has different functions in different programs 

 

F1 = HELP 

F2 = Jump 

F3 = Previous Menu/Return 

F4 = Close Open Programs 

F5 = Start up in Safe Mode 

F6 = Next Message 

F7 = Backward Scroll 

F8 = Open in Windows Boot Menu (Safe Mode) 

F9 = Update 

F10 = Previous Function 

F11 = Startup the Recovery Progam 

F12 = Open ‘Save As’ in Word 

 

******************************************************************************

*** 
 

Create Stationery 

Q. How can I create Stationery in Outlook? 

Ans. If Microsoft Word is your e-mail editor, you can't create new stationery from Word. 

However, you can create a new stationery in Microsoft Outlook, which Word then adds to its 

stationery list.  

1. From the main Outlook window, on the Tools menu, click Options, and then click the 

Mail Format tab.  

2. In the Compose in this message format list, click HTML.  

3. Click Stationery Picker, and then click New.  

4. In the Enter a name for your new stationery box, enter a name.  

5. Under Choose how to create your stationery, select the option you want.  

To select a file to base your stationery on, type the path and file name in the Use this file 

as a template box, or click Browse to select from a list. 

6. Click Next.  

7. Select the options you want to use.  

Note  This procedure is available only if you use HTML as your message format. 



 

********************************************************************** 

Since Win 7 the Outlook Express is no longer part of the Windows Operating System.  You 

may however use Outlook. 

 
Outlook the Default Email Program 

 
1. Open Microsoft Outlook  
2. Click Tools…Options…Other  
3. Click General tab.  
4. Click the box by Make Outlook the Default Program for Email, Contacts & Calendar. 

************************************************************* 
 
Fonts changing when using Msword via Outlook to send email. 
 
Internet Explorer for Windows: 
1. Go to Tools ,Internet Options, Accessibility. The page is Internet Options. The Tab is General.    
2.Check the option to "Ignore font sizes specified on Web page 
3. Click OK and then OK again on Internet options page. 

********************************************************************** 

"Win 7 Font Default in Win Mail 

To permanently set the default font face and color for new messages in Windows 
Live Mail, Windows Mail or Outlook Express:  

Go to the icon at the top left of Windows live mail (beside the ‘message’ icon), click on 
the triangle (down arrow) and from the dropdown menu select options, mail, compose 
and then font settings.  

 

• Select Tools | Options... from the menu in Windows Live Mail, Windows Mail or 
Outlook Express.  

o In Windows Live Mail, you may have to hold down the Alt key to see the 
menu bar. 

• Go to the Compose tab.  
• Under Compose Font, click the Font Settings... button next to Mail:.  
• Choose the desired font and color.  
• Click OK. 

Does The Font Still Look Unnaturally Small? 

If you have changed your default font to a larger type but still can barely see what you 
are typing, it may be your reading font settings' fault. Check in the main Windows Mail 
or Outlook Express window under View | Text Size.  

Default Stationery Overrides Default Font 



Note: to make sure Windows Live Mail, Windows Mail or Outlook Express is using the 
font you just specified no default stationery must be defined or its font settings will be 
used no matter what you specified under Font Settings.... 

Suggested Reading 

• How to Change the New Mail Sound in Outlook, Windows Live Mail, Windows 
Mail...  

• How to Create a Signature in Windows Live Mail, Windows Mail or Outlook 
Express  

• How to Change the Font Size of the Windows Mail or Outlook Express Message 
List 

******************************************************************* 

Win Live Mail Groups 

  

1.   Click Address Book at bottom left corner of WLM’s main window. 
2.   Click NEW 

3.   CLICK  GROUP or click Create a new Group at the bottom of the contacts 
list. 

4.   Enter the New Group information such as Name of new group. 
5.   Select contacts to be added to this new group. To remove a name just 

uncheck the name. 
6.   Click SAVE 
******************************************** 

Windows Mail: Setting up an account from start to finish 

Windows Live Mail is for Windows 7 and Vista. 

Click here: Windows Live Mail 2011  

Setting up your e-mail is a bit like setting up a new computer: You do it only once. After 

you configure your e-mail accounts in Windows Mail, you never have to hassle with it 

again—unless, of course, you open a new e-mail account. 

Windows Mail allows you to send and receive messages from multiple e-mail accounts. 

You can set up Windows Mail to work with many types of providers, from the biggest, 

most popular e-mail services all the way down to the smallest Internet service provider 

(ISP). 

Managing multiple e-mail accounts is simplified because each account in Windows Mail 

is organized in its own folder. You can check for messages from all your e-mail accounts 

at once by clicking a single button. But first, you'll need to set up each e-mail account 

one at a time in Windows Mail much as you did if you used Outlook Express. 



You can add multiple e-mail accounts in Windows Mail, and send and receive e-mail for 

all of them from one location just like you could setup different email accounts in 

Outlook Express by just clicking Tools…Accounts…ADD and enter the ISP(ex. 

Embarqmail.com), 

Type in the server incoming  pop.embarqmail.com  and the outgoing server 

smtp.embarqmail.com  and check the authentication box. 

In the user box type email address  jane34@embarqmail.com add the password you used 

for you embarqmail.com account 

Don’t be confused 

Before you set up Windows Mail, start by collecting the following information for each 

e-mail account. You will need to enter this information during the setup process: 

• Your e-mail address and password.  

• The type of e-mail server your e-mail service uses.  

• The address of the incoming and outgoing e-mail servers used by your e-mail 

provider. 

Most people know their e-mail addresses and passwords, but many people get 

confused when asked to enter information about e-mail servers. This is easiest if you 

gather some basic information from your e-mail provider before you begin adding 

accounts in Windows Mail. 

E-mail server types 

Windows Mail supports three types of e-mail servers. You don’t need to understand the 

details about these server types; you just need to find out which one your e-mail service 

uses both for incoming and outgoing e-mail: 

• Post Office Protocol 3 (POP3) servers. Most e-mail services and ISPs use this type of 

server, especially for personal e-mail accounts. They hold incoming e-mail messages 

until you check your e-mail, at which point they're transferred to your computer. 

Messages are typically deleted from the server when you check your e-mail.  
• Internet Message Access Protocol (IMAP) servers, such as AOL. These servers let you 

work with e-mail messages without downloading them to your computer first. You can 

preview, delete, and organize messages directly on the e-mail server. Copies are stored on 

the server until you delete them. IMAP is commonly used for business e-mail accounts.  
• Simple Mail Transfer Protocol (SMTP) servers. This outgoing mail server handles the 

sending of your e-mail messages to the Internet. An SMTP server handles only the 

outgoing e-mail, and is used in conjunction with a POP3 or IMAP incoming e-mail 

server. 



Incoming and outgoing e-mail servers 

Once you know the type of e-mail server used by each of your e-mail accounts, you 

must find out the address of its incoming and outgoing e-mail servers. During the setup 

process, Windows Mail requires you to enter the address of each e-mail server. There 

are only two types of incoming servers to choose from: POP3 or IMAP. 

Before you set up an e-mail account in Windows Mail, you need to know the address of 

the incoming and outgoing e-mail servers used by your e-mail provider  

POP3 is by far the most common type of incoming e-mail server for personal e-mail 

accounts. And SMTP is the only type of outgoing e-mail server that works with Windows 

Mail, so you normally don’t even need to check the outgoing server type with your 

e-mail provider. Practically all personal e-mail accounts—with the exception of web-

based e-mail—use an SMTP server for outgoing e-mail. 

E-mail server addresses usually have the same format. Most ISPs (named “myisp” in this 

example) have server addresses like this: 

• Incoming server: pop.myisp.com (or imap.myisp.com, if they use an IMAP server)  

• Outgoing server: smtp.myisp.com 

You can usually substitute the name of your ISP in place of myisp in the example above. 

If this doesn’t work, check with your ISP. Questions about e-mail server addresses are 

among the most common inquiries e-mail providers get, so they usually have this 

information posted in the support section of their websites. 

Here are server addresses for some of the most popular e-mail services: 

• Yahoo!: pop.mail.yahoo.com (incoming) and smtp.mail.yahoo.com (outgoing)  

• AOL: imap.aol.com (incoming) and smtp.aol.com (outgoing)  

• Gmail: pop.gmail.com (incoming) and smtp.gmail.com (outgoing)  

• Embarqmail: pop.embarqmial.com and smtp.embarqmail.com  

Finally, you must know whether your outgoing e-mail server requires authentication, 

since there is a check box for this when you set up a new e-mail account in Windows 

Mail. If you can’t find out the answer from your e-mail provider, try sending a test 

message with the check box selected and another one with the check box cleared, to 

see which works. 



Note: Several years ago Comcast had Outlook Express users change their port from 25 to port 

587.  If you’re using Win Live Mail and having trouble sending email, try changing the port 

from 25 to 587.  This has worked for some Win Live Mail folks with problems. 

Note2:Some e-mail services, such as Yahoo! Mail, require a premium subscription for POP3 

access. 

Web-based e-mail and Windows Live Mail 

Many people want to know if they can send and receive Windows Live Hotmail in 

Windows Mail. The answer is ‘NO’ ,  Windows Mail does not support the HTTP servers 

used by Hotmail and other web-based e-mail services. 

However, you can set up Hotmail and other web-based e-mail accounts to work with 

Windows Live Mail. This allows you to store and read Hotmail messages even when you 

are not connected to the Internet. 

Windows Live Mail includes the familiar features of Windows Mail, the mail program 

included in Windows Vista, plus new features such as the ability to automatically enter 

the correct settings for e-mail servers used by popular e-mail services, including 

Windows Live Hotmail, Yahoo!, AOL, and Gmail. 

Windows Live Mail also works with e-mail services from other e-mail providers and ISPs, 

although you will have to configure those accounts manually. 

To download Windows Live Mail, go to the Windows Live Mail website.  

 

Windows Mail Step by step Setup 

Once you have collected the required information for each e-mail account, you can start 

setting up Windows Mail. Here’s how to add an e mail account in Windows Mail: 

1. Open Windows Mail by clicking the Start button , clicking All Programs, and then 

clicking Windows Mail.  

2. Click the Tools menu, and then click Accounts.  

3. Click Add. 

After you click Add on the Internet Accounts screen, Windows Mail will ask what 

type of account you want to add 



4. Click E-mail Account, click Next, and then follow the instructions. 

After you are done entering all the information for one e-mail account, repeat the 

process for each e-mail account you want to set up, if you want to add more than the 

one account. 

Note 

During setup, you'll be asked to pick a display name. You might want to enter your 

actual name here rather than your e-mail address, since this is the name that recipients 

will see when you send them an e-mail message. 

Importing your e-mail, & contacts,into Windows Live Mail 

Ready to install Windows 7? Great! One thing you'll need to know before you begin, though, is that some 

familiar programs—like Outlook Express, Windows Mail, Windows Calendar, and Windows Address 

Book—aren't included in this version of Windows. But don't worry, you've got a couple of new options 

for getting to your e-mail, contacts, and calendars. 

You can use a free online service like Windows Live, which is a convenient way to go because you can 

access all your information from any computer with an Internet connection. 

But if you want to have all your data on your PC even when you're offline, you'll need to install a new 

desktop e-mail program, such as Windows Live Mail, part of Windows Live Essentials, a free suite of 

programs designed to link what you do on your desktop with what you do online.  

Once you've installed Windows Live Mail on your PC, you'll be able to import your existing e-mail 

messages, calendars, and contacts from Outlook Express (if you're upgrading from Windows XP or earlier) 

or Windows Mail (if you're upgrading from Windows Vista). You can also set it up to work with Hotmail 

and other e-mail providers—like Gmail, Yahoo! Mail Plus, or your Internet service provider (ISP)—to keep 

track of all your e-mail accounts in one place. To learn more about Windows Live Mail, see So long, 

Outlook Express! 

Making the switch to Windows Live Mail 

The steps you'll need to follow to get started with Windows Live Mail will depend on what type of 

Windows 7 installation you're doing—an upgrade or a custom installation. To find out more about 

installing Windows 7, see Installing and reinstalling Windows 7. To download Windows Live Mail, go to the 

Windows Live Mail website. 

Error! Hyperlink reference not valid.  

 If you're upgrading to Windows 7 from Windows Vista



Using the Upgrade option during Windows 7 installation will keep your files and settings from 

Windows Vista in place—including your e-mail, contacts, and calendars. Then, when you start 

Windows Live Mail for the first time, it will automatically import your data. 

If you're already using Windows Live Mail in Windows Vista, good news: You won't have to do anything 

special to get up and running after you finish upgrading to Windows 7. Just open and use it as you 

normally do. 

 If you're doing a custom installation of Windows 7

Choosing the Custom option during installation doesn't preserve your programs, files, and settings. That 

includes your e-mail, contacts, and calendars—whether you're using Windows Mail, Outlook Express, or 

another program. So you'll need to back up your e-mail, calendars, and contacts—along with any other 

files and settings you want to preserve—by copying them to an external hard disk or a USB flash drive. 

We recommend using Windows Easy Transfer, a free download, to do this backup. If you're upgrading 

from Windows XP, see Upgrading from Windows XP to Windows 7. If you're upgrading from Windows Vista, 

see Upgrading from Windows Vista to Windows 7 (custom installation). 

After Windows 7 is installed on your PC, you can use Windows Easy Transfer again to move all your files 

and settings back to your computer. Then, after you download and install Windows Live Mail, you can 

import your data. 

Top of page 

Importing e-mail and contacts into Windows Live Mail 

After you've moved your e-mail and contacts from the external hard disk or USB flash drive back to your 

PC and installed Windows Live Mail, you're ready to import your data into Windows Live Mail. 

Error! Hyperlink reference not valid.  

 To import e-mail

1.      Open Windows Live Mail by clicking the Start button . In the search box, type Windows Live Mail, 

and then, in the list of results, click Windows Live Mail. 

2.      Click the File menu, and then point to Import.  

3.      Click Messages, and then choose the e-mail program from which you want to import e-mail 

messages. 

4.      Click Next, and then follow the on-screen instructions. Your imported messages will appear in the 

folder list under Storage folders. 

 To import contacts

1.      Open Windows Live Mail by clicking the Start button . In the search box, type Windows Live Mail, 

and then, in the list of results, click Windows Live Mail. 

2.      In the lower-left corner of the Windows Live Mail window, click Contacts. 



3.      Click the File menu, point to Import, and then click the type of address book that you want to 

import. 

If prompted, browse to the file that contains the contact information that you want to import, click 

it, and then click Open. 

*********************************************** 

  
  

  

My Gun 

Today I swung my front door wide open and placed my Remington 870 right in the doorway.  I 

gave it 6 shells, then left it alone and went about my business.  

  

While I was gone, the mailman delivered my mail, the neighbor boy across the street mowed the 

yard, a girl walked her dog down the street, and quite a few cars stopped at the stop sign near the 

front of our house. 

After about an hour, I checked on the gun. It was still sitting there, right where I had left it.  It 

hadn't moved itself outside.  It certainly hadn't killed anyone, even with the numerous 

opportunities it had been presented to do so.  

  

In fact, it hadn't even loaded itself.  Well, you can imagine my surprise, with all the media uproar 

about how dangerous guns are and how they kill people. 

  

Either the media is wrong, or I'm in possession of the laziest gun in the world. 

  

.....Well, I'm off to check on my spoons. I hear they're making people fat.  

  

 

 

 

 

 



 

  

  
  

JmaxJmaxJmaxJmax  

Jmax's Website   http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  
 


